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Example 1: Steel 

This example will explain step by step the creation of a basic 3D steel structure. This example will be 

most effective if the user practice the illustrated skills as they are presented. 

The structure to be entered in this example is shown below: 

 

In order to simplify data entry, frame members are grouped as follows: 

 

The assignment of the member descriptions shown here will be illustrated in this example. 

1) Starting a new structure 

 

Select New from the RAM Elements button menu.  

In the event that there is an existing model open, RAM Elements will ask to save it. 

Test for Gray Color

Test for GreenYellow Color

Test for Honeydew Color

Test for HotPink Color
Test for IndianRed Color

Test for Indigo Color

Test for Ivory Color

Test for Khaki Color

Test for Lavender Color

Test for LavenderBlush Color

Test for LawnGreen Color

Test for LemonChiffon Color

Test for LightBlue Color

Test for LightCoral Color

Test for LightCyan Color

Test for LightGoldenrodYellow Color

Test for LightGray Color

Test for LightGreen Color

Test for LightPink Color

Test for LightSalmon Color

Test for LightSeaGreen Color
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Press the button on the status bar, a menu will be displayed. Then, select the option Units 

configuration. 

 

Select the English default unit system in the window displayed. 

Test for LightSkyBlue Color

Test for LightSlateGray Color

Test for LightSteelBlue Color

Test for LightYellow Color

Test for Lime Color

Test for LimeGreen Color

Test for Linen Color

Test for Magenta Color

Test for Maroon Color

Test for MediumAquamarine Color

Test for MediumBlue Color

Test for MediumOrchid Color

Test for MediumPurple Color

Test for MediumSeaGreen Color

Test for MediumSlateBlue Color

Test for MediumSpringGreen Color

Test for MediumTurquoise Color

Test for MediumVioletRed Color

Test for MidnightBlue Color

Test for MintCream Color
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2) Entering node coordinates 

In the coordinates spreadsheet enter the coordinates shown below: 

 

Go to the Spreadsheet Nodes/Coordinates and enter the coordinates shown above. 

 

The entered nodes are shown on the screen. 

3) Generation of frame members 

Select the "path" of the frame members. Select the nodes in the sequence shown below, and then 

connect the selected nodes by pressing  

 

Select the nodes in the order shown. To select several nodes remember to press the SHIFT key while 

clicking with the mouse. 

Test for MistyRose Color

Test for Moccasin Color

Test for NavajoWhite Color

Test for OldLace Color

Test for Olive Color

Test for OliveDrab Color

Test for Orange Color

Test for OrangeRed Color

Test for Orchid Color

Test for PaleGoldenRod Color

Test for PaleGreen Color

Test for PaleTurquoise Color

Test for PaleVioletRed Color

Test for PapayaWhip Color

Test for PeachPuff Color

Test for Peru Color

Test for Plum Color

Test for PowderBlue Color

Test for RoyalBlue Color

Test for RosyBrown Color
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Go to the Spreadsheet Members/Nodes and Description 

Then press  to generate the frame members. 

 

As can be seen the frame members were generate. 

NOTE. - Remember that it is possible to undo the last operation by pressing  

4) Assigning a description 

It is necessary to group frame members in order to simplify later operations such as selection of 

elements, optimization, and others. To assign the same description to every member of a group 

proceed as follows: 

 

Select columns 

Test for SaddleBrown Color

Test for Salmon Color

Test for SandyBrown Color

Test for SeaGreen Color

Test for SeaShell Color

Test for Sienna Color

Test for Silver Color

Test for SkyBlue Color

Test for SlateBlue Color

Test for SlateGray Color

Test for Snow Color

Test for SpringGreen Color

Test for SteelBlue Color

Test for Tan Color

Test for Teal Color

Test for Thistle Color

Test for Tomato Color

Test for Transparent Color

Test for Turquoise Color

Text on each page



Example 1: Steel 

5 

 

 

Then assign the description to the selected members selecting the Column (additive) option. 

Note. – To view the member descriptions graphically (on the screen) go to View tab, Model group, 

press the  button and select the option Description by element from the menu displayed.  

Repeat the steps explained previously to assign a Description to the other members: 

 

Select members 

 

Assign the description to the selected members selecting the Beam (additive) option. 

Generate the beam as shown in the figure below. Assign BEAM2 description to this newly created 

member: 

Test for White Font

Test for Black Font

Test for Brown Font

Test for Navy Font

Test for Blue Color

Test for PinkColor

Test for Purple Color

Test for Yellow Color

Test for Red Color

Test for AliceBlue Color

Test for Antique White Color

Test for Aqua Color

Test for Aquamarine Color

Test for Azure Color

Test for Beige Color

Test for Violet Color

Test for Wheat Color

Test for WhiteSmoke Color

Test for YellowGreen Color
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To create the horizontal beam, select the nodes shown in this figure and press  

 

Assign the description to the selected members selecting the Beam (additive) option. 

5) Segmenting Members  

To segment frame members, follow these steps: 

 

Select members to be segmented. 

 

Test for Bisque Color

Test for BlanchedAlmond Color

Test for BlueViolet Color

Test for BurlyWood Color

Test for CadetBlue Color

Test for Chartreuse Color

Test for Chocolate Color

Test for Coral Color

Test for Cornflower Blue Color

Test for Cornsilk Color

Test for Crimson Color

Test for Cyan Color

Test for Dark Cyan Color

Test for Dark Golden Rod Color

Test for DarkGray Color

Test for DarkGreen Color

Test for DarkKhaki Color

Test for DarkMagenta Color

Test for DarkOliveGreen Color

Test for DarkOrange  Color
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Press from the menu displayed after pressing the  button located in the ribbon 

(visible when the Members tab is the current page in the spreadsheet and connectivity button is 

pressed) and enter the desired number of segments (3 segments in this case). Then press OK. Notice 

that in this case 3 physical elements will be created. 

 

Next, segment the horizontal member BEAM2. To do this: 

 

Select BEAM2 member. 

 

Press  and enter the desired number of segments. In this case, enter six segments. Then press OK 

or the ENTER key. 

 

Test for Dark Blue

Test for DarkOrchid Color

Test for DarkRed Color

Test for DarkSalmon Color

Test for DarkSeaGreen Color

Test for DarkSlateBlue Color

Test for DarkSlateGray Color

Test for DarkTurquoise Color

Test for DarkViolet Color

Test for DarkPink Color

Test for DeepSkyBlueColor

Test for DimGray Color

Test for DodgerBlue Color

Test for FireBrick Color

Test for FloralWhite Color

Test for ForestGreen Color

Test for Fuchsia Color

Test for Gainsboro Color

Test for GhostWhite Color

Test for Gold Color

Test for Goldenrod Color

Test for Green Color
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NOTE. - Remember that it is possible to undo the last operation by pressing . 

Notice that the segmented members have the same description as the original member and that each 

member is treated as one physical member. 

6) Generation of vertical members 

To enter the vertical truss elements, follow these steps: 

 

Select the nodes shown in this figure. Notice that it is not necessary to select the exterior nodes. 

 

 

Press button  to generate vertical members (plus y generates members in the vertical up 

direction). 

7) Generation of diagonal members 

At first, generate the diagonal truss web members of the left side of the structure, and then the right 

side. 

Diagonal members on the left side: 

END OF THE FONT COLORS DEMO
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Select the nodes in the order shown in this figure. 

 

Press  from the ribbon (the button is visible when the Members tab is the current 

page in the spreadsheet and connectivity button is pressed). 

To enter diagonals on the right side proceed in the same way. 

NOTE. - Remember that it is possible to undo the last operation by pressing . 

The differences between the two buttons are as follows: 

   This button connects the selected nodes in a continuous line. 

   This button connects alternate pairs of nodes with a fragmented line. That is, the first member 

is generated between the first pair of selected nodes, the second member between the second pair of 

selected nodes, etc. 

8) Assigning a Description to members 

Follow these steps to assign a Description to the internal web members: 

a) Select diagonal and vertical (internal) elements using the button  (Home tab, Selection group) 
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To select the elements select one member of each group and then press . Remember that this 

button selects elements with a common description. In this case all internal elements belong to the 

group that does not have a description yet. That is to say they all have the same empty description. 

b) Internal elements will be assigned a DIAG1 description. Since there is no button available to 

assign this description (as opposed to COL1 and BEAM1 buttons), it is necessary to enter it 

manually: 

 

Enter DIAG1 description and then press   located at Spreadsheet tab, Spreadsheet group, to fill 

the column with the value. Another way to do this would the access to command from the popup menu 

displayed after right click on the spreadsheet area, having selected the desired rows to fill previously. 

Important - Descriptions are very important to select groups of frame members. It is also important 

to have entered the descriptions correctly. If this has not been done correctly the user may experience 

some difficulty following the next steps in this example. 

9) Copying the structure 

It is advisable to enter all the descriptions of a structure before copying it, because when a structure is 

copied the Descriptions are also copied. 

To copy a structure, follow these steps: 

 

Select all the elements that should be copied. In this case, press  (Home tab, Data tab) to select 

the entire structure. 

Execute the Copy command (Home tab, Modeling group). 
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Enter the number of copies and the distances in X, Y, and Z between each copy. In this case, enter the 

values shown in this figure. Then press OK. 
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10) Generation of the roof beams (purlins)  

To generate the roof beams, follow these steps: 

 

Select the initial nodes or end nodes of the roof beams. 

 

Then press  (Press button  if nothing occurs). Note that the +/- refers to the direction that 

the members are projected. 
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Note. - Notice that the middle portal is not connected to the roof beams. The model can be left 

without making any changes and the program will interpret the roof beams as continuous physical 

members. However, if the roof beams are going to be modeled as simply supported beams (as they 

normally are), it is necessary to segment the beams and connect one end to the middle portal. The 

command Segment Selection  may be applied in this case. 

 

Notice that roof beams do not connect with the middle frame 

 

With the roof beams selected, press   to split roof beams and connect them with the middle 

portal. It is necessary to select the member and the node of the middle portal that will become the 

point of break. 

Text on each page



Example 1: Steel 

14 

 

Choose the options shown in the figure. The members will be divided into two physical members. 

11) Assigning a Description to roof beams 

To assign a Description to roof beams, proceed as follows: 

a) Select roof beams by description. 

 

Select a member of the group and then press . Since the selected element does not have a 

description, all members with empty description will be selected. 

b) ROOF1 description will be assigned to roof beams. There is no button available to automatically 

assign the description (as opposed to COL1 and BEAM1 descriptions). Therefore, the Description 

has to be entered manually: 
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Enter ROOF 1 under description and then press  to fill the column with the entered value. 

Generating DIAG2 and BEAM3 members 

Now proceed to enter the DIAG2 and BEAM3 members that are shown in the figure below. Generate 

these elements as explained before. 

 

12) Supports 

To enter supports proceed as follows: 

 

Select support nodes 
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Go to the Spreadsheet Nodes/Restraints and click on the corresponding support. In this case click on 

the  button. 

 

The Supports have been entered 

13) Assigning sections to frame members. 

To assign a section to some member, and this section is available in the section database, proceed as 

follows: 

Select the members to which a section will be assigned. In this case, select all the columns. 
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To do this, first select one column and press . 

 

Then go to the Spreadsheet Members/Sections. Select W10x12 profile and press  (double click on 

the profile will assign the selected item). 

Assign sections to all members of the structure in a similar manner. 

 

To select all the elements of the truss, select one element of each group and press . 
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Assign section T2L 2-1_2x2-1_2x1_4 to the truss elements. 

Now assign sections to the DIAG2 and BEAM3 elements 

 

Select the elements DIAG2 and BEAM3 
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Assign section T2L 2x2x1_4 

14) Adding sections to the database. 

In this example, a cold-formed C-section will be assigned to the Roof beams. This cold-formed C 

(with lips) profile is not available in the section database. Therefore, a new section should be added. 

Proceed as follows: 

 

Go to the Home tab, Databases group and execute the Sections button 
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Press the  button to add a New group to the database. After that, a name for the new group is 

required in the displayed window: 

  

 

Then, add a new Table by pressing the  button. A new dialog will be displayed to enter the name 

for the new table. It is also required to select the type of table, to perform this action press the  

button and the following dialog will be shown: 
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In the dialog window, select the desired type of profile and press OK. In this case, select the aisiClip 

profile. 

 

Once the type of table is selected, a LEO file for the definition of the type of sections is assigned to 

the table.  

Press the  button to create a new item (section) for the current table. 
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Select the units system (English) and enter the values of the profile. In this case, enter the values 

shown in the figure. Do not forget to enter the name. 

Note. - The name of a section should have the following format: 

Type<space>description 

For example, W 10x45, where W is the type and 10x45 the description. 

The space character should be placed after the type name.  A description of the section should be 

entered. For example 10x25, 10x15x2 (the "/" character is not accepted. It should be replaced by "_" 

(underscore) character) 

Note – A section “Type” is determined by the characters entered before the space, e.g. W, C etc 

Tip. - The Description of the profile should be self-explanatory containing the dimensions of the 

profile or other pertinent data.  

Example of valid names: 

ROOF 10X15X25 

W 10X25 

2L 15x2 unequal 

Example of non-valid names: 

W10x25 (space between Type and Description is missing) 

W15/22 ("/" character is not accepted. Replace it with "_" (underscore) character) 

15x22 (Type is missing) 

Press OK and notice that a new section "Roof  3x6x1" has been created and saved into the sections 

database. A new "ROOF" group, which will contain all profiles of type "ROOF”, has been created.  

Important. - The Type of a profile determines the group in which this profile will be saved. Thus a 

"W 10x22" profile will be saved in a "W" group or type. In the same way a "TUBE 15x22" profile 

will be saved in a "TUBE" group. If the group does not exist, RAM Elements automatically creates a 

new group. 
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Remark. Note that the program already has a section with the name “Roof  3x6x1”. The procedure 

described previously explains adequately the manner to perform this operation. It is recommendable 

that the user practices the creation of new sections for the structure in order to acquire proficiency in 

this task. 

To assign the new section to the roof beams proceed as follows: 

 

Select roof beams 

 

Assign the section by pressing . 

15) Assigning materials 

In this example, all material elements are of steel grade A36. To assign the material, proceed with 

these steps: 

Select elements to which a material will be assigned. In this case, select all the elements of the 

structure by pressing . 

Text on each page



Example 1: Steel 

24 

 

Go to the Spreadsheet Members/Materials. Double click on the desired material, or select it and 

press  

Material “A36” from folder Steel has been assigned to all elements. 

Note. - To show/hide the section and material names on the screen, press the  button and 

the   button from the View tab, Model group. 

16) Articulated joints (pinned joints) 

By default, all frame members are rigidly connected (fixed) to the nodes. This condition is 

appropriate to model a fully welded joint. 

For joints that cannot resist flexural moments it is necessary to release the respective moments so the 

model adequately represents the real structure. An element is pinned when both ends of the members 

are released to both bending moments. To pin a member proceed as follows: 
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Select the members to be pinned. In this case, select DIAG1 and DIAG2 elements. To do this, select 

one DIAG1 element and one DIAG2 element. Then press . 

 

Go to the Spreadsheet Members/Hinges (Releases) and press button . 

Note. - To rigidly connect pinned elements, press . 

 

Elements have been pinned 
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17) Rotating columns 

Pressing  (in the View tab, Model group) the elements with three-dimensional sections are 

displayed. This allows the user to see whether the elements are orientated correctly in space or need 

to be rotated. If necessary, sections can be rotated as required. Tool buttons are available to rotate a 

member 90 and 180 degrees, or as required. In this case, the middle columns will be rotated by 90 

degrees. 

 

Press button  to see the element profiles in 3D. 

 

Columns in the middle will be rotated 90 degrees. 

To rotate 90 degrees, proceed as follows: 
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Select columns to be rotated 

 

Go to the Spreadsheet Members/Local axes and press button . 

18) Rotating beams 180 degrees 

In this example, the elements shown below need to be rotated 180 degrees. 

 

BEAM2, BEAM3 elements need to be rotated 180 degrees 

To do this, follow the next steps: 
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Select BEAM2 and BEAM3 elements (select one BEAM2 and BEAM3 elements and press button ). 

 

Go to the Spreadsheet Members/Local axes, and press button  to rotate 180 degrees. 

 

Elements have been rotated 180 degrees. 

Text on each page



Example 1: Steel 

29 

Note. - Notice that it is possible to rotate the members by entering the required angle in the 

spreadsheet and pressing  to fill the column with the entered value.  

19) Entering loads 

In this example, a 300 Lb/ft distributed force acting downward in the "Dead Load" case will be 

introduced. Concentrated forces of 1200 Lb, which are acting downward on the nodes, will be added 

as well. 

Notice that RAM Elements automatically creates a load case named "Dead Load". Therefore, it isn't 

necessary to create it. Later the user will see how to create a new load case and a load combination. 

Before entering a load, determine if it is a: 

1) Load on node 

2) Load on frame members, or 

3) Load on shell elements. 

Load on frame members 

To enter loads on frame members, proceed as follows: 

 

Select frame members where the load is acting. In this case, select beams on top of the truss. 
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Go to the Spreadsheet Members/Loads on members, select the adequate command tools by pressing 

the  button and then press the  button. 

 

Enter the value of the distributed load (do not enter the minus sign). Then press OK. 
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The load has been entered. 

Load on nodes 

To enter load forces on nodes, follow the next steps: 

 

Select the nodes on which the force is acting. 

 

Go to the Spreadsheet Nodes/Forces and moments, enter a force value (enter the –1.2 value) and 

press  to fill-in the column. 
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Notice that the force should include its sign. Forces on nodes have been entered. 

20) Creating Wind in X load case 

The Second load case acting on the structure is due to the wind force in the X direction. These steps 

show how to create a new load case: 

 

Execute the shown button located in the Home tab, Load conditions group to enter a new load case.  

 

Then enter a load condition identifier consisting of 2-4 characters (first character should not be a 

number), then enter a load description and the category. In this case, enter what is shown in the 

figure. Press OK and the new load case in the drop-down list will be shown. 

 

Text on each page



Example 1: Steel 

33 

Drop-down list for load cases at the status bar. 

Note that it is necessary to select a category. This feature is very useful to generate load combinations 

based on their categories. The user can create a template file for the local building code from which 

load combinations can be generated (based on the load case category, DL for dead loads, LL for live 

loads, etc.). The program is capable to generate load combinations according to the design standards 

it handles and it has example files (located at main RAM Elements directory/combos) which have the 

basic load combinations to consider for the different codes. For more details see the chapter of Other 

Advanced Subjects in the program manual. 

21) Entering wind loads 

In this case, wind loads are applied perpendicular to the roof. There is a pressure of 150 Lb/ft on the 

left side of the roof, and a suction of 200 Lb/ft on the right side of the roof. Wind load entry is similar 

to the entry made before for the dead load condition. Notice that the distributed forces act 

perpendicular to the elements, not parallel to Y-axis. To enter these loads, proceed as follows: 

 

Select the elements on which the load acts. In this case, select one member of each portal and press 

 to select the aligned elements. 

 

Go to the Spreadsheet Members/Loads on members and press the  button. 
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Enter the value of the distributed force (do not enter the minus sign), and press OK. 

 

The distributed forces of the left side of the structure have been entered. 
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To enter the forces on the right side of the structure proceed as before. The load should be seen as 

illustrated in the figure. 

Notice that it is necessary to press button  instead of button  to enter suction. 

22) Creating load combinations 

In this example, the following load combination will be created: 

1.1dl + 1.2wx (1.1 times dead load plus 1.2 times wind in X) 

To create it proceed as follows:  

 

Execute the shown button located in the Home tab, Load conditions group to enter a new load case.  

Fill the combination equation factors in the second spreadsheets in the dialog window that appears. 
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In the dialog window, enter the information shown in the figure. 

a) Enter a load condition identifier of two to four characters (the first character should not be a 

number).  

b) Enter the formula factors for the load combination (1.1 for dl and 1.2 for wx). 

 

Then press OK and the new load combination in the drop-down list for load cases at the status bar 

will be shown. 
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Notice that the formula factors can contain the minus sign. For example, a -1.2 factor for wx load 

case would define "1.1dl -1.2wx"  

Note. - It is not possible to enter or edit loads data while a load combination is selected as the current 

load condition. Notice that the spreadsheets are locked for edition to enter loads. 

23) Analyzing the structure 

After the structure has been defined, the model is ready to be analyzed, designed, optimized and the 

results can be viewed. 

To analyze the structure proceed as follows: 

 

Execute Analyze model by pressing the shown button in the Process tab, Process group. 

For this example a Second Order Analysis (P-Delta) will be performed. This analysis takes longer to 

analyze a structure as it involves iteration, but it is more accurate. In addition, buckling instability is 

detected in certain cases when P-Delta analysis is performed. For more about P-Delta analysis, see 

the Chapter of Analysis in the Manual. 
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Select the same options as shown in the figure above. Then press the Analyze button. 

24) Designing the structure 

 

Select the command Design all in the Process tab, Process group. 
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After that, a dialog window will be shown to specify the design standard to be used in the design of 

members. For this example select AISC 360-05, AISI-01 (ASD) for steel members. The other 

material options may use the code defined by default. 

 

Select the design code shown above and press the Design button. 

Once the elements are designed, the user has the option to optimize the sections with the following 

command. 

 

Select the command Optimize model in the Process tab, Process group. 

For this example the optimization is not performed. 

25) View results graphically 

As can be seen, several buttons (in the Analysis and Design groups of the View tab) are enabled once 

the structure has been analyzed and designed. These newly enabled buttons allows the user to select 

what results to display. 

 

Result buttons from the Analysis and Design groups are enabled when the structure has been 

analyzed/designed. 

In order to see results graphically, press the button corresponding to those desired items, and then 

select the elements to see the results. 

Notice that the selected display options will only be seen on the selected elements. 
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Select the load condition. 

26) Deformed shape  

One of the first display options that should be viewed is the deformed shape of the structure. 

 

To see the deformed shape, press . The graphic shown corresponds to the Wind in 

X load case. 

In this view the elements are drawn as lines. To see the deformed shape with the original shape select 

the option . 

27) 3D Sections Deformed shape 

It is possible to see the deformed shape with the extruded sections. 

 

 Activate the deformed shape accessing the option from the Rendering button menu (View tab, Model 

group). Notice that this view may take a longer time to draw. 
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 The graphic shown corresponds to the Dead load case. 

28) Stress 

Another important view option is the information related to the element stress contour. This is of 

particular importance in light gage structures where stress concentrations are significant to the design. 

 

Press the  button to see frame member stresses. Note that the button has a menu where 

there are some options to see the stresses in the deformed shape or in shrunken members. 

To select only those elements that are stressed within a certain range, mark a block of stresses with 

the mouse and press . 

Text on each page



Example 1: Steel 

42 

 

To see element stresses within a certain range, mark the range and press . 

 

RAM Elements selects those elements whose maximum stress is within the marked range of stresses. 

Note that the remaining members are recalibrated (color changes). 

Note. – To see only the axial stress (without bending moments, press ). 
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29) Stress and deformation 

 

To view stress and deformation of the elements, activate these buttons . 

30) Forces diagrams  

 

The buttons shown above (View tab, Analysis group, Member forces displayed menu) allow the user 

to see the forces diagrams of the frame members: 

Bending moment around element axis 3 (Typically strong axis bending) 
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Bending moment around element axis 2 (Typically weak axis bending) 

 

Shear forces in element axis 2 (typically weak axis) (Dead load case) 

 

Shear forces in element axis 3 (typically strong axis) (Dead load case) 
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Torsion (Wind in X load case) 

 

Axial forces (Dead load case) 

 

Select the Show values option (Member forces menu) to simultaneously display the magnitude of the 

forces.  
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Select  Show units option (menu displayed for units at the status bar) to display the units.  

 

31) Displacements of nodes 

To see the nodal displacement values, press  (View tab, Analysis group) and 

choose the degree of freedom to be viewed: 

 

The relation between a degree of freedom and its respective displacement in the global coordinate 

system is as follows: 

1: Tx: X translation 
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2: Ty: Y translation 

3: Tz:  Z translation 

4: Rx: Rotation about X  

5: Ry: Rotation about Y 

6: Rz: Rotation about Z 

Note. – Notice that X, Y, and Z represents the global coordinate system. 

Each element has its own system of coordinates, named local axes. These axes are designated with 

the numbers 1, 2 and 3, which are equivalent to X, Y, and Z-axis. Local axes are Cartesian and follow 

the right hand rule. To see the local axes, press  (View tab, Model group). 

 

Press  and the degree of freedom corresponding to the displacement. 

To see the displacement units press the Show units option in the Units menu at the status bar. 

.  

32) Reactions 

To see reactions, press  (View tab, Analysis group) and the degree of freedom 

corresponding to the desired action. 
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This is the relation between degree of freedom and force: 

1: Tx: X force 

2: Ty: Y force 

3: Tz: Z force 

4: Rx: Moment about X 

5: Ry: Moment about Y 

6: Rz: Moment about Z 

 

Press   and the degree of freedom that corresponds to the desired reaction. (Case: Wind 

in X) 

33) Deflections 

One of the most important results of an analysis is the ratio between deflection and length of the 

element. To view this ratio press  (View tab, Analysis group). 

 

Options displayed in the Deflections button menu. 

This ratio may vary across an element. RAM Elements displays the maximum ratio found within an 

element.  

Note. – The Defl/L ratio should never exceed a value suggested by the design code and judgement. 
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Press  to see the element colored Defl/L ratios. 

 

In this panel mark a range of Defl/L ratios and press  to select the elements that have slopes 

within the marked range. 

34) Deflection values 

To see the Deflection values (in function of L) in local axis 2 direction, selection 

option . 

To see the Deflection values (in function of L) in local axis 3 direction, press 

button . 
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Deflection in function of L for the Load combination C1. 

35) Design: Colored Interaction Values 

To view interaction values graphically, by color, press  (View tab, Design group). 

Important! 

To view the interaction colors scaled from 0 to 1.0, press . To view the controlling 

interaction value for all Load Combinations (not load cases) press 

 

 

Press  to see interaction values. 

To select the elements with stress ratio within a certain range, mark a range of stress ratios and 

press . 

 

Mark a block with the mouse and press button  to select elements with stress ratio within the 

range. 

Note that most of the results displayed to this point are for the selected load condition. 
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36) Design: Interaction Values  

To see interaction values for the currently selected load condition, press 

 

 

Choose the Stress ratio option to view interaction values for the current load condition. The last 

option of the menu should be enabled to see the ratios for the governing load combination. 

37) Design: OK and NG (No Good) elements 

To view the elements that failed code check (for the current load condition), press  (View tab, 

Design group): 
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Press   to view elements that failed code check. 

 

Press button  to see elements that pass code check. 

 

  

Press button  to quickly select all elements that failed code check. 

The user can print the results of the steel design in a report. To print them, go to the Output tab, 

Reports group. For more information about reports see the Printing Graphics and Reports Chapter in 

the manual. 

The user can also use the optimization feature that is valid only for steel and wood members. This 

option allows the user to change the existing sections with sections that are recommended (based on 

explicit criteria) from a collection of sections. In other words, the original section can be replaced 

with another that resists the imposed loads with an allowable deflection and that is located above the 

original section in the list of sections specified for the optimization. To use the optimization feature 

go to the Process tab, Process group, Optimize model command. For more details see Chapter 11: 

Steel and Wood Structure Optimization and Code Check of the Manual. 
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Example 1: Steel 

This example will explain step by step the creation of a basic 3D steel structure. This example will be 

most effective if the user practice the illustrated skills as they are presented. 

The structure to be entered in this example is shown below: 

 

In order to simplify data entry, frame members are grouped as follows: 

 

The assignment of the member descriptions shown here will be illustrated in this example. 

1) Starting a new structure 

 

Select New from the RAM Elements button menu.  

In the event that there is an existing model open, RAM Elements will ask to save it. 
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Press the button on the status bar, a menu will be displayed. Then, select the option Units 

configuration. 

 

Select the English default unit system in the window displayed. 
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2) Entering node coordinates 

In the coordinates spreadsheet enter the coordinates shown below: 

 

Go to the Spreadsheet Nodes/Coordinates and enter the coordinates shown above. 

 

The entered nodes are shown on the screen. 

3) Generation of frame members 

Select the "path" of the frame members. Select the nodes in the sequence shown below, and then 

connect the selected nodes by pressing  

 

Select the nodes in the order shown. To select several nodes remember to press the SHIFT key while 

clicking with the mouse. 
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Go to the Spreadsheet Members/Nodes and Description 

Then press  to generate the frame members. 

 

As can be seen the frame members were generate. 

NOTE. - Remember that it is possible to undo the last operation by pressing  

4) Assigning a description 

It is necessary to group frame members in order to simplify later operations such as selection of 

elements, optimization, and others. To assign the same description to every member of a group 

proceed as follows: 

 

Select columns 
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Then assign the description to the selected members selecting the Column (additive) option. 

Note. – To view the member descriptions graphically (on the screen) go to View tab, Model group, 

press the  button and select the option Description by element from the menu displayed.  

Repeat the steps explained previously to assign a Description to the other members: 

 

Select members 

 

Assign the description to the selected members selecting the Beam (additive) option. 

Generate the beam as shown in the figure below. Assign BEAM2 description to this newly created 

member: 
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To create the horizontal beam, select the nodes shown in this figure and press  

 

Assign the description to the selected members selecting the Beam (additive) option. 

5) Segmenting Members  

To segment frame members, follow these steps: 

 

Select members to be segmented. 

 

Test for Bisque Color

Test for BlanchedAlmond Color

Test for BlueViolet Color

Test for BurlyWood Color

Test for CadetBlue Color

Test for Chartreuse Color

Test for Chocolate Color

Test for Coral Color

Test for Cornflower Blue Color

Test for Cornsilk Color

Test for Crimson Color

Test for Cyan Color

Test for Dark Cyan Color

Test for Dark Golden Rod Color

Test for DarkGray Color

Test for DarkGreen Color

Test for DarkKhaki Color

Test for DarkMagenta Color

Test for DarkOliveGreen Color

Test for DarkOrange  Color

Text on each page



Example 1: Steel 

7 

Press from the menu displayed after pressing the  button located in the ribbon 

(visible when the Members tab is the current page in the spreadsheet and connectivity button is 

pressed) and enter the desired number of segments (3 segments in this case). Then press OK. Notice 

that in this case 3 physical elements will be created. 

 

Next, segment the horizontal member BEAM2. To do this: 

 

Select BEAM2 member. 

 

Press  and enter the desired number of segments. In this case, enter six segments. Then press OK 

or the ENTER key. 
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NOTE. - Remember that it is possible to undo the last operation by pressing . 

Notice that the segmented members have the same description as the original member and that each 

member is treated as one physical member. 

6) Generation of vertical members 

To enter the vertical truss elements, follow these steps: 

 

Select the nodes shown in this figure. Notice that it is not necessary to select the exterior nodes. 

 

 

Press button  to generate vertical members (plus y generates members in the vertical up 

direction). 

7) Generation of diagonal members 

At first, generate the diagonal truss web members of the left side of the structure, and then the right 

side. 

Diagonal members on the left side: 

END OF THE FONT COLORS DEMO
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Select the nodes in the order shown in this figure. 

 

Press  from the ribbon (the button is visible when the Members tab is the current 

page in the spreadsheet and connectivity button is pressed). 

To enter diagonals on the right side proceed in the same way. 

NOTE. - Remember that it is possible to undo the last operation by pressing . 

The differences between the two buttons are as follows: 

   This button connects the selected nodes in a continuous line. 

   This button connects alternate pairs of nodes with a fragmented line. That is, the first member 

is generated between the first pair of selected nodes, the second member between the second pair of 

selected nodes, etc. 

8) Assigning a Description to members 

Follow these steps to assign a Description to the internal web members: 

a) Select diagonal and vertical (internal) elements using the button  (Home tab, Selection group) 
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To select the elements select one member of each group and then press . Remember that this 

button selects elements with a common description. In this case all internal elements belong to the 

group that does not have a description yet. That is to say they all have the same empty description. 

b) Internal elements will be assigned a DIAG1 description. Since there is no button available to 

assign this description (as opposed to COL1 and BEAM1 buttons), it is necessary to enter it 

manually: 

 

Enter DIAG1 description and then press   located at Spreadsheet tab, Spreadsheet group, to fill 

the column with the value. Another way to do this would the access to command from the popup menu 

displayed after right click on the spreadsheet area, having selected the desired rows to fill previously. 

Important - Descriptions are very important to select groups of frame members. It is also important 

to have entered the descriptions correctly. If this has not been done correctly the user may experience 

some difficulty following the next steps in this example. 

9) Copying the structure 

It is advisable to enter all the descriptions of a structure before copying it, because when a structure is 

copied the Descriptions are also copied. 

To copy a structure, follow these steps: 

 

Select all the elements that should be copied. In this case, press  (Home tab, Data tab) to select 

the entire structure. 

Execute the Copy command (Home tab, Modeling group). 
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Enter the number of copies and the distances in X, Y, and Z between each copy. In this case, enter the 

values shown in this figure. Then press OK. 
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10) Generation of the roof beams (purlins)  

To generate the roof beams, follow these steps: 

 

Select the initial nodes or end nodes of the roof beams. 

 

Then press  (Press button  if nothing occurs). Note that the +/- refers to the direction that 

the members are projected. 
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Note. - Notice that the middle portal is not connected to the roof beams. The model can be left 

without making any changes and the program will interpret the roof beams as continuous physical 

members. However, if the roof beams are going to be modeled as simply supported beams (as they 

normally are), it is necessary to segment the beams and connect one end to the middle portal. The 

command Segment Selection  may be applied in this case. 

 

Notice that roof beams do not connect with the middle frame 

 

With the roof beams selected, press   to split roof beams and connect them with the middle 

portal. It is necessary to select the member and the node of the middle portal that will become the 

point of break. 
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Choose the options shown in the figure. The members will be divided into two physical members. 

11) Assigning a Description to roof beams 

To assign a Description to roof beams, proceed as follows: 

a) Select roof beams by description. 

 

Select a member of the group and then press . Since the selected element does not have a 

description, all members with empty description will be selected. 

b) ROOF1 description will be assigned to roof beams. There is no button available to automatically 

assign the description (as opposed to COL1 and BEAM1 descriptions). Therefore, the Description 

has to be entered manually: 
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Enter ROOF 1 under description and then press  to fill the column with the entered value. 

Generating DIAG2 and BEAM3 members 

Now proceed to enter the DIAG2 and BEAM3 members that are shown in the figure below. Generate 

these elements as explained before. 

 

12) Supports 

To enter supports proceed as follows: 

 

Select support nodes 
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Go to the Spreadsheet Nodes/Restraints and click on the corresponding support. In this case click on 

the  button. 

 

The Supports have been entered 

13) Assigning sections to frame members. 

To assign a section to some member, and this section is available in the section database, proceed as 

follows: 

Select the members to which a section will be assigned. In this case, select all the columns. 
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To do this, first select one column and press . 

 

Then go to the Spreadsheet Members/Sections. Select W10x12 profile and press  (double click on 

the profile will assign the selected item). 

Assign sections to all members of the structure in a similar manner. 

 

To select all the elements of the truss, select one element of each group and press . 
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Assign section T2L 2-1_2x2-1_2x1_4 to the truss elements. 

Now assign sections to the DIAG2 and BEAM3 elements 

 

Select the elements DIAG2 and BEAM3 
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Assign section T2L 2x2x1_4 

14) Adding sections to the database. 

In this example, a cold-formed C-section will be assigned to the Roof beams. This cold-formed C 

(with lips) profile is not available in the section database. Therefore, a new section should be added. 

Proceed as follows: 

 

Go to the Home tab, Databases group and execute the Sections button 
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Press the  button to add a New group to the database. After that, a name for the new group is 

required in the displayed window: 

  

 

Then, add a new Table by pressing the  button. A new dialog will be displayed to enter the name 

for the new table. It is also required to select the type of table, to perform this action press the  

button and the following dialog will be shown: 
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In the dialog window, select the desired type of profile and press OK. In this case, select the aisiClip 

profile. 

 

Once the type of table is selected, a LEO file for the definition of the type of sections is assigned to 

the table.  

Press the  button to create a new item (section) for the current table. 
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Select the units system (English) and enter the values of the profile. In this case, enter the values 

shown in the figure. Do not forget to enter the name. 

Note. - The name of a section should have the following format: 

Type<space>description 

For example, W 10x45, where W is the type and 10x45 the description. 

The space character should be placed after the type name.  A description of the section should be 

entered. For example 10x25, 10x15x2 (the "/" character is not accepted. It should be replaced by "_" 

(underscore) character) 

Note – A section “Type” is determined by the characters entered before the space, e.g. W, C etc 

Tip. - The Description of the profile should be self-explanatory containing the dimensions of the 

profile or other pertinent data.  

Example of valid names: 

ROOF 10X15X25 

W 10X25 

2L 15x2 unequal 

Example of non-valid names: 

W10x25 (space between Type and Description is missing) 

W15/22 ("/" character is not accepted. Replace it with "_" (underscore) character) 

15x22 (Type is missing) 

Press OK and notice that a new section "Roof  3x6x1" has been created and saved into the sections 

database. A new "ROOF" group, which will contain all profiles of type "ROOF”, has been created.  

Important. - The Type of a profile determines the group in which this profile will be saved. Thus a 

"W 10x22" profile will be saved in a "W" group or type. In the same way a "TUBE 15x22" profile 

will be saved in a "TUBE" group. If the group does not exist, RAM Elements automatically creates a 

new group. 
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Remark. Note that the program already has a section with the name “Roof  3x6x1”. The procedure 

described previously explains adequately the manner to perform this operation. It is recommendable 

that the user practices the creation of new sections for the structure in order to acquire proficiency in 

this task. 

To assign the new section to the roof beams proceed as follows: 

 

Select roof beams 

 

Assign the section by pressing . 

15) Assigning materials 

In this example, all material elements are of steel grade A36. To assign the material, proceed with 

these steps: 

Select elements to which a material will be assigned. In this case, select all the elements of the 

structure by pressing . 
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Go to the Spreadsheet Members/Materials. Double click on the desired material, or select it and 

press  

Material “A36” from folder Steel has been assigned to all elements. 

Note. - To show/hide the section and material names on the screen, press the  button and 

the   button from the View tab, Model group. 

16) Articulated joints (pinned joints) 

By default, all frame members are rigidly connected (fixed) to the nodes. This condition is 

appropriate to model a fully welded joint. 

For joints that cannot resist flexural moments it is necessary to release the respective moments so the 

model adequately represents the real structure. An element is pinned when both ends of the members 

are released to both bending moments. To pin a member proceed as follows: 
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Select the members to be pinned. In this case, select DIAG1 and DIAG2 elements. To do this, select 

one DIAG1 element and one DIAG2 element. Then press . 

 

Go to the Spreadsheet Members/Hinges (Releases) and press button . 

Note. - To rigidly connect pinned elements, press . 

 

Elements have been pinned 
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17) Rotating columns 

Pressing  (in the View tab, Model group) the elements with three-dimensional sections are 

displayed. This allows the user to see whether the elements are orientated correctly in space or need 

to be rotated. If necessary, sections can be rotated as required. Tool buttons are available to rotate a 

member 90 and 180 degrees, or as required. In this case, the middle columns will be rotated by 90 

degrees. 

 

Press button  to see the element profiles in 3D. 

 

Columns in the middle will be rotated 90 degrees. 

To rotate 90 degrees, proceed as follows: 

Text on each page



Example 1: Steel 

27 

 

Select columns to be rotated 

 

Go to the Spreadsheet Members/Local axes and press button . 

18) Rotating beams 180 degrees 

In this example, the elements shown below need to be rotated 180 degrees. 

 

BEAM2, BEAM3 elements need to be rotated 180 degrees 

To do this, follow the next steps: 
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Select BEAM2 and BEAM3 elements (select one BEAM2 and BEAM3 elements and press button ). 

 

Go to the Spreadsheet Members/Local axes, and press button  to rotate 180 degrees. 

 

Elements have been rotated 180 degrees. 
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Note. - Notice that it is possible to rotate the members by entering the required angle in the 

spreadsheet and pressing  to fill the column with the entered value.  

19) Entering loads 

In this example, a 300 Lb/ft distributed force acting downward in the "Dead Load" case will be 

introduced. Concentrated forces of 1200 Lb, which are acting downward on the nodes, will be added 

as well. 

Notice that RAM Elements automatically creates a load case named "Dead Load". Therefore, it isn't 

necessary to create it. Later the user will see how to create a new load case and a load combination. 

Before entering a load, determine if it is a: 

1) Load on node 

2) Load on frame members, or 

3) Load on shell elements. 

Load on frame members 

To enter loads on frame members, proceed as follows: 

 

Select frame members where the load is acting. In this case, select beams on top of the truss. 
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Go to the Spreadsheet Members/Loads on members, select the adequate command tools by pressing 

the  button and then press the  button. 

 

Enter the value of the distributed load (do not enter the minus sign). Then press OK. 
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The load has been entered. 

Load on nodes 

To enter load forces on nodes, follow the next steps: 

 

Select the nodes on which the force is acting. 

 

Go to the Spreadsheet Nodes/Forces and moments, enter a force value (enter the –1.2 value) and 

press  to fill-in the column. 
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Notice that the force should include its sign. Forces on nodes have been entered. 

20) Creating Wind in X load case 

The Second load case acting on the structure is due to the wind force in the X direction. These steps 

show how to create a new load case: 

 

Execute the shown button located in the Home tab, Load conditions group to enter a new load case.  

 

Then enter a load condition identifier consisting of 2-4 characters (first character should not be a 

number), then enter a load description and the category. In this case, enter what is shown in the 

figure. Press OK and the new load case in the drop-down list will be shown. 
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Drop-down list for load cases at the status bar. 

Note that it is necessary to select a category. This feature is very useful to generate load combinations 

based on their categories. The user can create a template file for the local building code from which 

load combinations can be generated (based on the load case category, DL for dead loads, LL for live 

loads, etc.). The program is capable to generate load combinations according to the design standards 

it handles and it has example files (located at main RAM Elements directory/combos) which have the 

basic load combinations to consider for the different codes. For more details see the chapter of Other 

Advanced Subjects in the program manual. 

21) Entering wind loads 

In this case, wind loads are applied perpendicular to the roof. There is a pressure of 150 Lb/ft on the 

left side of the roof, and a suction of 200 Lb/ft on the right side of the roof. Wind load entry is similar 

to the entry made before for the dead load condition. Notice that the distributed forces act 

perpendicular to the elements, not parallel to Y-axis. To enter these loads, proceed as follows: 

 

Select the elements on which the load acts. In this case, select one member of each portal and press 

 to select the aligned elements. 

 

Go to the Spreadsheet Members/Loads on members and press the  button. 
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Enter the value of the distributed force (do not enter the minus sign), and press OK. 

 

The distributed forces of the left side of the structure have been entered. 
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To enter the forces on the right side of the structure proceed as before. The load should be seen as 

illustrated in the figure. 

Notice that it is necessary to press button  instead of button  to enter suction. 

22) Creating load combinations 

In this example, the following load combination will be created: 

1.1dl + 1.2wx (1.1 times dead load plus 1.2 times wind in X) 

To create it proceed as follows:  

 

Execute the shown button located in the Home tab, Load conditions group to enter a new load case.  

Fill the combination equation factors in the second spreadsheets in the dialog window that appears. 
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In the dialog window, enter the information shown in the figure. 

a) Enter a load condition identifier of two to four characters (the first character should not be a 

number).  

b) Enter the formula factors for the load combination (1.1 for dl and 1.2 for wx). 

 

Then press OK and the new load combination in the drop-down list for load cases at the status bar 

will be shown. 
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Notice that the formula factors can contain the minus sign. For example, a -1.2 factor for wx load 

case would define "1.1dl -1.2wx"  

Note. - It is not possible to enter or edit loads data while a load combination is selected as the current 

load condition. Notice that the spreadsheets are locked for edition to enter loads. 

23) Analyzing the structure 

After the structure has been defined, the model is ready to be analyzed, designed, optimized and the 

results can be viewed. 

To analyze the structure proceed as follows: 

 

Execute Analyze model by pressing the shown button in the Process tab, Process group. 

For this example a Second Order Analysis (P-Delta) will be performed. This analysis takes longer to 

analyze a structure as it involves iteration, but it is more accurate. In addition, buckling instability is 

detected in certain cases when P-Delta analysis is performed. For more about P-Delta analysis, see 

the Chapter of Analysis in the Manual. 
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Select the same options as shown in the figure above. Then press the Analyze button. 

24) Designing the structure 

 

Select the command Design all in the Process tab, Process group. 
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After that, a dialog window will be shown to specify the design standard to be used in the design of 

members. For this example select AISC 360-05, AISI-01 (ASD) for steel members. The other 

material options may use the code defined by default. 

 

Select the design code shown above and press the Design button. 

Once the elements are designed, the user has the option to optimize the sections with the following 

command. 

 

Select the command Optimize model in the Process tab, Process group. 

For this example the optimization is not performed. 

25) View results graphically 

As can be seen, several buttons (in the Analysis and Design groups of the View tab) are enabled once 

the structure has been analyzed and designed. These newly enabled buttons allows the user to select 

what results to display. 

 

Result buttons from the Analysis and Design groups are enabled when the structure has been 

analyzed/designed. 

In order to see results graphically, press the button corresponding to those desired items, and then 

select the elements to see the results. 

Notice that the selected display options will only be seen on the selected elements. 
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Select the load condition. 

26) Deformed shape  

One of the first display options that should be viewed is the deformed shape of the structure. 

 

To see the deformed shape, press . The graphic shown corresponds to the Wind in 

X load case. 

In this view the elements are drawn as lines. To see the deformed shape with the original shape select 

the option . 

27) 3D Sections Deformed shape 

It is possible to see the deformed shape with the extruded sections. 

 

 Activate the deformed shape accessing the option from the Rendering button menu (View tab, Model 

group). Notice that this view may take a longer time to draw. 

Text on each page



Example 1: Steel 

41 

 

 The graphic shown corresponds to the Dead load case. 

28) Stress 

Another important view option is the information related to the element stress contour. This is of 

particular importance in light gage structures where stress concentrations are significant to the design. 

 

Press the  button to see frame member stresses. Note that the button has a menu where 

there are some options to see the stresses in the deformed shape or in shrunken members. 

To select only those elements that are stressed within a certain range, mark a block of stresses with 

the mouse and press . 
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To see element stresses within a certain range, mark the range and press . 

 

RAM Elements selects those elements whose maximum stress is within the marked range of stresses. 

Note that the remaining members are recalibrated (color changes). 

Note. – To see only the axial stress (without bending moments, press ). 
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29) Stress and deformation 

 

To view stress and deformation of the elements, activate these buttons . 

30) Forces diagrams  

 

The buttons shown above (View tab, Analysis group, Member forces displayed menu) allow the user 

to see the forces diagrams of the frame members: 

Bending moment around element axis 3 (Typically strong axis bending) 
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Bending moment around element axis 2 (Typically weak axis bending) 

 

Shear forces in element axis 2 (typically weak axis) (Dead load case) 

 

Shear forces in element axis 3 (typically strong axis) (Dead load case) 
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Torsion (Wind in X load case) 

 

Axial forces (Dead load case) 

 

Select the Show values option (Member forces menu) to simultaneously display the magnitude of the 

forces.  
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Select  Show units option (menu displayed for units at the status bar) to display the units.  

 

31) Displacements of nodes 

To see the nodal displacement values, press  (View tab, Analysis group) and 

choose the degree of freedom to be viewed: 

 

The relation between a degree of freedom and its respective displacement in the global coordinate 

system is as follows: 

1: Tx: X translation 

Text on each page



Example 1: Steel 

47 

2: Ty: Y translation 

3: Tz:  Z translation 

4: Rx: Rotation about X  

5: Ry: Rotation about Y 

6: Rz: Rotation about Z 

Note. – Notice that X, Y, and Z represents the global coordinate system. 

Each element has its own system of coordinates, named local axes. These axes are designated with 

the numbers 1, 2 and 3, which are equivalent to X, Y, and Z-axis. Local axes are Cartesian and follow 

the right hand rule. To see the local axes, press  (View tab, Model group). 

 

Press  and the degree of freedom corresponding to the displacement. 

To see the displacement units press the Show units option in the Units menu at the status bar. 

.  

32) Reactions 

To see reactions, press  (View tab, Analysis group) and the degree of freedom 

corresponding to the desired action. 
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This is the relation between degree of freedom and force: 

1: Tx: X force 

2: Ty: Y force 

3: Tz: Z force 

4: Rx: Moment about X 

5: Ry: Moment about Y 

6: Rz: Moment about Z 

 

Press   and the degree of freedom that corresponds to the desired reaction. (Case: Wind 

in X) 

33) Deflections 

One of the most important results of an analysis is the ratio between deflection and length of the 

element. To view this ratio press  (View tab, Analysis group). 

 

Options displayed in the Deflections button menu. 

This ratio may vary across an element. RAM Elements displays the maximum ratio found within an 

element.  

Note. – The Defl/L ratio should never exceed a value suggested by the design code and judgement. 
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Press  to see the element colored Defl/L ratios. 

 

In this panel mark a range of Defl/L ratios and press  to select the elements that have slopes 

within the marked range. 

34) Deflection values 

To see the Deflection values (in function of L) in local axis 2 direction, selection 

option . 

To see the Deflection values (in function of L) in local axis 3 direction, press 

button . 
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Deflection in function of L for the Load combination C1. 

35) Design: Colored Interaction Values 

To view interaction values graphically, by color, press  (View tab, Design group). 

Important! 

To view the interaction colors scaled from 0 to 1.0, press . To view the controlling 

interaction value for all Load Combinations (not load cases) press 

 

 

Press  to see interaction values. 

To select the elements with stress ratio within a certain range, mark a range of stress ratios and 

press . 

 

Mark a block with the mouse and press button  to select elements with stress ratio within the 

range. 

Note that most of the results displayed to this point are for the selected load condition. 
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36) Design: Interaction Values  

To see interaction values for the currently selected load condition, press 

 

 

Choose the Stress ratio option to view interaction values for the current load condition. The last 

option of the menu should be enabled to see the ratios for the governing load combination. 

37) Design: OK and NG (No Good) elements 

To view the elements that failed code check (for the current load condition), press  (View tab, 

Design group): 
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Press   to view elements that failed code check. 

 

Press button  to see elements that pass code check. 

 

  

Press button  to quickly select all elements that failed code check. 

The user can print the results of the steel design in a report. To print them, go to the Output tab, 

Reports group. For more information about reports see the Printing Graphics and Reports Chapter in 

the manual. 

The user can also use the optimization feature that is valid only for steel and wood members. This 

option allows the user to change the existing sections with sections that are recommended (based on 

explicit criteria) from a collection of sections. In other words, the original section can be replaced 

with another that resists the imposed loads with an allowable deflection and that is located above the 

original section in the list of sections specified for the optimization. To use the optimization feature 

go to the Process tab, Process group, Optimize model command. For more details see Chapter 11: 

Steel and Wood Structure Optimization and Code Check of the Manual. 
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